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FCC Compliance Statement 

Certified to comply with Class B limits, FCC Rules Part 15. See the next section 
if interference to radio reception is suspected. 

This equ ipment has been tested and found to comply with the limits for a Class B dig ital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in residential Installations. This equipment generates, uses 
and can radiate radio frequency energy, and if not Installed and used In accordance with the instrucMns, may cause harmful interference with 
radio communications. However, there is no guarantee that interference will not occur In a particular installation. 

If this equipment does cause interference to radio or television equipment reception , which can be determined by tuming the equ ipment off and 
on, the user Is encouraged to try to correct the Interference by one or more of the following measures: 

reorient or relocate the receiving antenna, 
relocate the computer with respect to the receiver, 
plug the equipment Into an outlet on a circuit different from that to which the receiver is powered. 
move the computer away from the receiver, 
if necessary, the user should consult the dealer or an experienced radlo/televlslon technician for additional suggestions. 

Caution: Only equipment certified to comply with Class B (computer inpuVoutput devices, terminals, printers, etc.) should be attached to this 
equipment, and must have shielded interface cables. Finally, any changes or modifications to the equipment by the user not expressly approved 
by the grantee or manufacturer could void the users authorily to operate such equipment. 

Copyright 
This guide and the software described in it are copyrighted with all rights reserved. U~,der the copyright laws, neither this 
guide nor the software may be copied , in whole or part, without written consent of Thunderware, Inc. except in normal use 
of the software or to make a backup copy. This exception does not allow copies to be made for others, whether or not sold , 
or for multiple copies to be used at the same time, but all of the materials purchased (with all backup copies) may be sold , 
given, or loaned to another person. Under the law, copying includes translating into another language, format or using 
multiple copies. Copyright © 1989 - 1990, Thunderware , Inc. All rights reserved . 

APPLE COMPUTER, INC. ("APPLE") MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE 
APPLE SOFTWARE. APPLE DOES NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE 
OR THE RESULTS OF THE USE OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, 
CURRENTNESS OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE 
IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE 
EXCLUSION MAY NOT APPLY TO YOU. 

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY 
TO USE THE APPLE SOFTWARE EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE 
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL 
DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. Apple's liability to you for actual damages from any cause 
whatsoever, and regardless of the form of the action (whether in contract, tort (including negligence), product liability or 
otherwise, will be limited to $50. 
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Chapter One - Before You Begin 

About LightningScan GS 
LightningScan GS, the hand-held scanner from Thunderware, was created specifically for 
use on any Apple lIes with at least S12K of memory. LightningScan allows you to scan 
images from nearly any flat surface. You can create scanned images from all sorts of 
materials: photographs, drawings, illustrations, logos, maps, sketches, halftones, hand­
writing, clothing, wallpaper, tile and other flat surfaces. 

Scanning is the process that puts an image into the Apple lIes. By rolling the scanner 
across a surface, the image is translated into a series of dots. This process is called 
digitizing. The pattern of dots used to represent different shades is called a dither. 
LightningScan has three dither settings as well as a setting for line art (images that are 
black and white and have no grays). Because LightningScan is hand-held, you can use it 
to create unusual special effects. After you have scanned an image, you can use 
brightness and contrast controls to fine-tune an image. Once you have your image 
"picture perfect", you can save it in a variety of formats. 

About the Software 
There are three applications and GS/OS included on a single 3-1/2 inch disk. 

• LightningScan GS is the program that lets you scan and save images. It also gives 
you control over the contrast and brightness of your images. 

• ThunderScan GS lets you open files, colorize images, print, and tile print. 

• ThunderScan also lets you open files, colorize images and print. You can also use 
ThunderScan to change images into High and Double Res images and has a special 
print grays option. 
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How To Use This Guide 
This guide shows you how to install the peripheral card and connect the scanner to your 
Apple IIGs. It has a lesson to teach you how to scan and save your images. The different 
scanning options available with LightningScan GS are also explained. 

This guide assumes that you are familiar with your Apple IIGs. You should know how to 
use the mouse, open applications and documents, do simple editing, and use the Finder. 
For more information, please refer to your Apple IIes User's Guide. 

This guide is divided into six chapters: 
• This chapter will help you make the best use of your equipment. 
• Chapter Two, Installing LightningScan, shows you how to install the peripheral card 

and connect the scanner to your computer. 
• Chapter Three, Learning LightningScan, explains how to scan and save your images. 
• Chapter Four, Using ThunderScan GS, explains how to use the ThunderScan GS 

application to open images, how to use the filter and histogram controls to change an 
image, and how to print. 

• Chapter Five, Using ThunderScan, explains how to use the ThunderScan application 
to open images, how to switch displays, and how to use the filter and histogram 
controls to change an image, and how to print. 

• The final chapter, Troubleshooting and Maintenance, gives advice about typical prob­
lems, maintenance, and storing the scanner. 

Making a Working Copy of the Software 
Before you start using your scanner, you'll want to use a utility program to make a 
working copy of your original disk. If something happens to the working disk, you still 
have the original disk to make another working copy. Once you have made a working 
copy, store the original disk in a safe place. If you are not using a hard disk, you should 
also have some formatted disks ready to store your scanned images. Image files can be 
quite large, so be sure to have plenty of disk space before scanning. 

Making the Best Use of Your System 
LightningScan GS stores images in memory (RAM). The more memory there is, the larger 
the area you will be able to scan. The following suggestions will help you free up addi­
tional memory. 
• Tum off the RAM Disk and RAM Cache in the Control Panel. 
• Tum off your Apple IIGS after making these changes and restart. 
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Setting Up Your System 
The programs come on a disk and are ready to use, but you may need to move files 
around to customize them for the equipment you have: 
• If you have a megabyte or more of memory, you should boot (that is, startup your 

computer) with GS/OS version 5.0.2 (included on the LightningScan GS disk). 
• If you have less than a megabyte of memory, you should boot with ProOOS 16 

instead of GS/OS. You'll be able to scan longer images at higher resolutions with 
ProDOS 16 because it requires less RAM to run than GS/OS. ProDOS 16 is not 
included on the LightningScan GS program disk, but is available from Thunderware 
at no charge. If you'd like Thunderware to send a ProD OS 16 version of the 
LightningScan GS disk, return your original LightningScan GS disk to Thunderware 
(be sure to make a copy for yourself first!) . Include a note with the disk requesting 
the ProDOS 16 version. 

Using LightningScan GS on a Hard Disk 
If you have a hard disk, you'll want to copy the file LightningScanGS from your work­
ing disk to your hard disk. To use the ThunderScan and ThunderScan GS programs 
included with LightningScan GS, you'll also want to copy the folders ThunderScan and 
ThunderScan.GS onto your hard disk. 
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Chapter Two - Installing LightningScan 

The Components of LightningScan GS 
Installing the scanner in your Apple lIes is easy. All you'll need is a Phillips screwdriver 
and these parts from the package: 
• The scanner, the device that transfers your images from paper into your Apple. 
• The peripheral card, the circuit board that transfers the data from the scanner to the 

computer. The peripheral card is connected to a connector card with a ribbon cable. 
The connector card connects the scanner to the peripheral card. 

• Snap Guide"', a plastic guide that attaches to the scanner to help you scan straight. 
• The rule, a 13 inch (33 cm) straight edge that is used with SnapGuide. 
• The tutorial image (mask), for learning how to scan. 
• This user's guide. 

Figure 2-1 
The components of LightningScan GS. 

Once you've unpacked everything, store the box in a safe place. Use the box when you 
need to transport your scanner. 
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Safety Precautions 
The scanner and peripheral card are sensitive electronic devices which can be damaged 
or cause harm if abused. They are not meant to be dropped, hit, or exposed to moisture. 
Improper installation or negligence may result in damage to the peripheral card, scanner, 
computer and/ or other peripherals. 

Like most computer products, the peripheral card and scanner are sensitive to static 
electricity. Be sure to discharge static by touching a grounded metal object before install­
ing the peripheral card. Take these precautions to protect yourself, your Apple IIGs, and 
all connected peripherals: 
• Never install or remove the peripheral card while your computer is powered on. 
• Never connect or disconnect the scanner while the computer is powered on. 
• Always keep your computer plugged into a grounded outlet while connecting or 

disconnecting the peripheral card. This keeps your computer system grounded. 

Removing the Lid from the Apple IIGS 
Before you open the lid of your Apple IIGs, switch off the power. If you have a monitor 
on top of your computer, set it aside. With your Apple IIGS in front of you, reach around 
each side and push on the lid latches. With the latches held in, gently lift the lid up with 
your thumbs and middle fingers. If you have any trouble, consult your Apple IIes Owner's 
Reference. 

Figure 2-2 
Removing the lid from the Apple IIGs. 
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Handling the Peripheral Card 
The peripheral card comes sealed in a plastic anti-static bag that protects the card against 
static electricity. As when handling any peripheral card, be sure to take these precautions 
with LightningScan GS: 
• Make sure the power to your computer is turned off, but keep the power cord 

plugged into a grounded outlet. This keeps your computer system grounded. 
• Handle the card only by its edges. Do not touch the gold contact fingers. These 

contacts carry information between your Apple lIes and the card. Dirt and other 
foreign substances on these contacts can damage the card. 

Figure 2-3 
The proper way to handle a peripheral card. 

Installing LightningScan GS 
The following sections explain how to install the peripheral card and connect the scanner 
to your Apple lIes. There are three main steps: 
• Attach the connector card to the back panel of your Apple lIes. 
• Install the peripheral card into a nearby empty slot. 
• Attach the scanner to the connector on the back of your Apple lIes. 

That's it! The following sections explain each of these steps in detail. 
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Installing the Connector Board 
The connector board is connected to the peripheral board with a ribbon cable. To install 
the connector board to the your Apple lIes: 
• Touch the power supply case inside the computer. This discharges any static electric­

ity that may be on your clothing or your body. 
• Place the peripheral card on the power supply case on top of the anti-static bag (see 

Figure 2-3). 

Figure 2-4 
The peripheral card resting on the power supply case. 

• Decide which slot you'll be using for the peripheral card. We recommend using 
either slot three or slot four, but any slot will work. 

• Find the small opening on the back panel of the Apple lIes above the disk drive port. 
Remove the plastic plug by turning the metal plug retainer (from inside the case) 90 
degrees counterclockwise. Then remove the plug itself. 

• Remove the screw from the connector board farthest from the ribbon cable. Partially 
loosen the other screw on the connector board. 

• Insert the connector board into the opening. The remaining screw on the connector 
board should rest in the screw recess at the bottom of the opening. 

• While holding the connector board into the opening (from inside the case), partially 
tighten the bottom screw with a Phillips screwdriver. Screw in and tighten the top 
screw and then tighten the bottom screw. 
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Figure 2-5 
Tightening the screws on the connector board. 

Installing the Peripheral Card 
The peripheral card can be installed in any slot, but we recommend using either slot 
three or slot four. If you are using AppleTalkTM, you cannot install the peripheral card in 
the AppleTalk slot. You can find out your AppleTalk slot in the Control Panel in the 
Apple menu (or by holding down the Command and Control keys while pressing 
Escape). To install the card: 
• Tum off your Apple lIes and all connected peripherals. Be sure to leave your Apple 

lIes plugged in. 
• Discharge any static by touching the power supply case. 
• Align the gold fingers with the slot. The side of the card with the integrated circuits 

should face away from the power supply case. When you handle the card, avoid 
touching the gold fingers along the bottom edge of the card. 

• Gently rock the card forward and back until it's firmly seated in the slot. You'll have 
to exert some pressure to seat the card securely in the slot, but don't wiggle it from 
side to side. 
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Figure 2-6 
Installing the peripheral card. 

• Check to be sure the peripheral card is completely seated in the slot. The peripheral 
card should be square with the logic board, not tilted to the front or rear. 

• Make sure the ribbon cable and connector board do not come in contact with any 
other cards you have installed. 

• Replace the cover on your Apple lIes. 

16 Chapter Two - Connecting LightningScan 



Figure 2-7 
The peripheral card and connector board installed. 

Connecting the Scanner 
To connect the scanner, make sure your computer is turned off. Plug the scanner cable 
into the port on the connector board. The arrow on the scanner's plug should point away 
from the power switch. Push the plug firmly to ensure that it is snugly in place. 
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Figure 2-8 
Connecting the scanner to LightningScan's connector board. 

Important Note: Never connect or disconnect the scanner with the computer turned on. 

About SnapGuide 
SnapGuide™ helps you align your scanner so it can scan straight. It snaps easily onto the 
scanner. 

Installing SnapGuide 
SnapGuide attaches to the back of the scanner by gripping the seam that joins the top and 
bottom of the scanner. To install SnapGuide: 
• Position SnapGuide underneath the scanner's cord with the lip facing up. 
• Snap the lip of SnapGuide into the seam. Note that the left side grips the dithering 

switch recess. SnapGuide's right side grips the resolution switch recess. 
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Figure 2-9 
SnapGuide completely installed on LightningScan. 

Where to Go Next 
Now that you've installed the peripheral and connector boards, connected the scanner to 
the Apple lIes and attached SnapGuide to the scanner, you're ready to learn how to scan. 
Chapter Three, Using LightningScan CS, shows you how. 
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Chapter Three - Using LightningScan GS 

This chapter has step-by-step instructions that will teach you the fundamentals of 
scanning with LightningScan GS. 

Learning to Use the Scanner Controls 
You can now tum your attention to the scanner itself. Look at Figures 3-1 and 3-2 to see 
the controls on the scanner. There are five: a dithering switch, a resolution switch, a 
brightness dial, a start button, and an overrun indicator. 

Figure 3-1 
The start button, dithering switch, and brightness dial. 

Figure 3-2 
The resol1,ltion switch. 

The Dithering Switch 
The dithering switch has four settings: three increasingly larger dots labeled PHOTO and 
a LETTER setting. The PHOTO setting uses dithering to simulate shades of gray by using 
patterns of black and white dots. The smallest dither setting (with the switch set to the 
smallest dot) works best for scanning photographs and other originals with a range of 
colors or grays. The larger dither settings can be used to create special effects. The final 
setting, marked LETTER, is for use with text and line art. The LETTER setting renders 
images in black and white only. 
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The Resolution Switch 
Resolution detennines the size and amount of detail in the image. The higher the resolu­
tion, the larger your images will appear on screen and the more memory your scanned 
image will require. Resolution is expressed in dots per inch (DPI). The higher the DPI, the 
greater the resolution. Each setting on the resolution switch equals 100 DPI. Thus, setting 
1 is 100 DPI, setting 2 is 200 DPI, and so on. 

The Brightness Dial 
The brightness dial detennines the brightness of the scan image. For a line art image, 
setting the dial at the halfway point usually works best. You can create different effects 
by changing the brightness while scanning. If your images are too light, make the image 
darker by turning the dial toward DARK. If your images are too dark, lighten them by 
turning the dial toward LIGHT. 

The best way to set brightness is to adjust the brightness dial while scanning. When the 
brightness on screen looks about right, press the R key to restart the scan using the best 
brightness setting for the original image. 

The Start Button 
The start button must be pressed during scanning. If the button is not pressed, nothing is 
scanned. You can combine many different images in one file by releasing the start button, 
positioning the scanner over another original, and continuing the scan. 

The Overrun Indicator 
Moving the scanner too quickly may cause your image to become distorted due to data 
loss. The overrun indicator flickers when you scan so quickly that the scanner cannot 
capture the image. Slowing your scan speed will steady the overrun indicator. If you 
continue to scan too fast, the indicator will tum off. This means that the image has been 
distorted by an overrun. 

Learning to Scan 
Scanning with LightningScan GS is fast and easy. Just follow these steps: 
• Boot a working copy of the LightningScan GS program disk. (If you are using a 

Unidisk, you'll need to use the Installer program to install the Unidisk drivers.) If 
you are using a hard disk, launch the LightningScan GS application. 

• Find the tutorial image that came with your scanner and put it on your desk. 
• Choose the finest dither setting (set at the smallest dot size). 
• Set the resolution switch to 300 DPI (position 3). 
• Set the brightness dial at the halfway point. 

22 Chapter Three - Learning UghtningScan GS 



If you're running from a copy of the program disk, the LightningScan GS Program 
Selector appears: 

Open an application Dr Cancel to shutdown 
iii 121 :LSCAM: 

~ 1::<""....H.I!J.JllI !Ill! , ( Disk ) 
~ProDOS 
D System 
D TSCAM ( Open ) D TSCAH.GS 

( Close ) 
~ ( Cancel ) 

Figure 3-3 
The LightningScan GS Program Selector. 

The Program Selector allows you to select the application you want to use. To launch 
LightningScan GS, double-click on LightningScan GS. 

Setting the Slot 
Before you begin, you will need to tell the program the slot where you installed the 
LightningScan GS peripheral card. To set the slot: 
• Choose Scanner Slot from the Scanner menu. 

A dialog box appears: 

Scanner Slot: 

1234567 
0000000 

( Canoe I ) [ (11< D 

Figure 3-4 
The scanner slot dialog box. 

• Click on the radio button that represents the slot where you installed the Light­
ningScan GS peripheral card (or press the number key of the slot you are using). 

• Click on the OK button (or press the Return key). 
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Your scanner slot setting is saved to a file named LS.CONFIG in the System Folder of the 
boot disk. The slot setting stays the same until you change it (unless your startup disk is 
locked). 

Selecting the Scan Mode and Display Option 
Now select New Scan ... from the Scanner menu (or press Command-N). The New Scan 
dialog box appears: 

Scan Mode: 

@ 16 graus 
010 graus 
o line art 

Max Scan Length: 

100DP I 655.4in 
200DP I 221.2in 
300DP I 9S.0in 
400DP I 55.3in 

r21 Displau during scan 

( Cancel) « OK D 

Figure 3-5 
The New Scan dialog box. 

The New Scan dialog box lets you select a Scan Mode. There are three options: 16 Grays, 
10 Grays, and Line Art. 
• The 16 Grays option is best for highest quality gray scale scanning. 
• The 10 Grays option creates images twice the size of the 16 Grays option. This option 

is best for images you wish to print using ThunderScan and ThunderScan GS 
software. 

• The Line Art option is best for highest quality line art scanning (images without 
intermediate shades). It creates very large files at high resolution settings. 

The New Scan dialog box has a checkbox for displaying the left part of the image as you 
scan. It's convenient to see part of the image while scanning to make sure you're 
scanning straight. You can scan faster when the Display During Scan box is not selected. 
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Before you begin scanning, it's important to know whether or not you'll have enough 
memory in your Apple IIGS to scan the image you want. Scanned images can take up a lot 
of memory, particularly at high resolution settings and when using the Line Art option. 
The Max. Scan Length indicates the maximum length in inches at the four scanner 
resolution settings given the available memory in your Apple IIGS and the scan mode 
selected. 

Your scan mode settings, like the scanner slot setting, are saved to the file LS.CONFIG in 
the System Folder of the startup disk. 

For purposes of learning how to scan, select 16 Grays for the Scan Mode and Display 
During Scan. 

Scanning 
Click on the OK button or press the Return key to start the scan. (Clicking on the Cancel 
button or pressing the ESC key returns you to the main window.) The scanner illumi­
nates and the scan window appears: 

Hold START button and drag scanner 

RETU~H=Done ESC=Cancel R=Restart 

Figure 3-6 
The scan window. 

Place the scanner's glowing LED strip just above the top edge of the tutorial image. Hold 
down the scanner's start button and slowly drag the scanner across the image. You must 
keep the start button pushed the entire time you are scanning. If you release the button, 
the scanner stops scanning. If you press the start button again, scanning continues. 
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As you scan, the screen starts filling with the image. The screen looks like this: 

Figure 3-7 
The scan window while scanning. 

The scan window shows only the left edge of the image, so the display may seem confus­
ing at first, but the image is being stored as a continuous strip. 

Scanning Speed 
At lower resolutions, you can move the scanner quickly. At higher resolutions, the 
scanner sends much more information to your Apple lIes. You'll need to move the 
scanner more slowly to capture all of the data. If you go too fast, your computer will 
make a low-pitched clicking sound to warn you to slow down. If you continue to scan 
too quickly, your computer will make a high pitched clicking sound to warn you that 
part of the image may have been lost. If you hear the high pitched clicking sound, you 
should press the R key to restart your scan. 

Important Note: If your computer does not beep when you overrun, check your speaker 
volume in the Control Panel. You may need to tum it up. 

Finishing the Scan 
When you are done scanning, press the Return key. After a moment, your image will 
appear in an untitled window. 
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Figure 3-8 
The tutorial image in an untitled window. 

Using SnapGuide 
LightningScan GS comes with a 13-inch rule for scanning with SnapGuide. To use 
SnapGuide: 
• Hold the rule to one side of the image to be scanned. 
• Position the scanner against the rule. 
• Drag the scanner alongside the rule while pressing the Start button. 

Figure 3-9 
Using SnapGuide. 
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Due to manufacturing variations in the scanner, you may need to rotate the scanner 
slightly to achieve perfect alignment. When scanning, you can look through the scanner's 
window to verify that your original is properly aligned with the scanner. If the image is 
slightly askew, reposition the rule and begin the scan again. 

Understanding the Relationship between 
Scan Mode and Resolution 
You can create an image of many different sizes and appearances with LightningScan GS. 
The Scan Mode and Resolution settings let you determine both the size and the "look" of 
you scanned images. Try experimenting with different modes and DPI settings to get the 
appearance you like. The chart below shows the different image sizes possible with each 
combination of settings. 

Line Art 10 Grays 16 Grays 

100DPI 2.9 1.0 0.5 

200DPI 5.8 1.9 1.0 

300DPI 10.1 3.4 1.7 

400DPI 13.5 4.5 2.5 

Figure 3-10 
Size of scanned image in relation to size of original with different Scan Mode and 
DPI settings. 

Scrolling 
You can scroll an image that is larger than the window - right or left, up or down. To 
scroll: 
• Move the pointer onto the arrows of either the vertical or the horizontal scroll bars of 

the image window. 
• Click the mouse button to move in small increments. 
• Slide the scroll box to move in larger increments. 

The Clipboard 
LightningScan GS does not support the Apple lIes Clipboard. The Edit menu, as well as 
the Undo, Cut, Copy, Paste and Gear commands are dimmed when using 
LightningScan GS. 
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Changing Brightness and Contrast 
The brightness and contrast controls are similar to the controls on a television set. The 
brightness control makes the image lighter or darker. The contrast control alters the 
range of grays in an image. When contrast is increased, dark grays become black and 
light grays become white. The brightness and contrast settings affect the entire image. 

To adjust the brightness and contrast of your image: 
• Select Brightness & Contrast from the Display menu (or press Command-B). 

The brightness and contrast controls appear on screen: 

100 0 

C B 

¢ OK D 
(Cancel] 

Figure3-U 
The brightness and contrast controls. 

The standard settings are 0 for brightness and 100 for contrast. To change the brightness 
and contrast: 
• Use the mouse and click on the arrows or drag the scroll box of the brightness and 

contrast scroll bars. 

Notice the changes to the image? Oick on the OK button (or press the Return key) when 
you have reached the satisfactory settings. Oick on the Cancel button (or press the ESC 
key if you wish to ignore your changes). 

Note: Some brightness and contrast settings cause the pointer to disappear. If this hap­
pens, press the ESC key to cancel your settings. 
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Inverting an Image 
The Invert command in the Display menu lets you invert your image. Blacks become 
white, light grays become dark grays, and dark grays become light grays. To invert your 
image, simply select Invert from the Display menu. If you aren't satisfied with the 
results, choosing Invert again will reverse the changes. 

Saving an Image 
After you've finished playing with your image, you may wish to save it. LightningScan 
GS saves images in many popular file formats so you can use them with almost any 
Apple IIGS program that uses graphics. 

To save a scanned image: 
• Select Save As ... from the File menu (or press Command-S). A dialog box appears: 

lil:LSCAH: 
13 free of SOOK 

IDTSCAH 
DTSCAH.GS 

Save Fil e Rs: 

@ ThunderScan 
o Apple Preferred 
o Single Screen 
o Paintworks 

Figure 3-12 
The Save dialog box. 

( Disk ) 
(t'l~~\fJ .. (It <1m· ) 

( Open ) 
( I: 1 I)!; I~ ) 

« ~;<nm ~ 
( Cancel ) 
@ 320 Hode 
06"10 Hode 
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Saving Images as ThunderScan Files 
Saving an image as a ThunderScan file saves the entire image that was scanned. Thun­
derScan files can be loaded into ThunderScan and ThunderScan GS where they can be 
altered, saved, and printed. It's a good idea to save your file as a ThunderScan file so that 
you can change and print it later. 

Saving Images as Screen Files 
Screen files can be used with a variety of different programs, but they cannot be loaded 
into ThunderScan and ThunderScan GS. LightningScan GS saves screen files in both 
Super Res display modes: 320 and 640. The 320 mode is best for using scanned images 
with painting programs such as Paintworks'" and DeluxePaint"'. The 640 mode is 
required for using scanned images with desktop publishing programs such as 
AppleWorks"'GS and GraphicWriter"'. Before saving an image as a screen file: 
• Make sure the brightness and contrast controls are set to your liking. 
• Select Show 320 Screen or Show 640 screen from the Display menu to view the 

image as it will be saved. 
• Use the scroll bars to position the image for saving. The Apple Preferred and 

Paintworks file formats save two screens of an image: the screen being viewed and 
the screen directly below it. The Single Screen format saves only the screen being 
viewed. 

• Select Save As ... from the File menu. Use the radio buttons to select the file format 
and mode. 

• Type in the file name. 
• Click on the Save button (or press the Return key). 

About Single Screen Files 
The Single Screen (type $Cl \0) file saves one screen of an image. It is an uncompressed 
file and will require 65 blocks on disk. Single Screen files can be imported into virtually 
any painting program. 

About Apple Preferred Files 
The Apple Preferred (type $CO\2) file saves two screens of an image: the screen being 
viewed and the one directly below it. Apple Preferred files are compressed. This file 
format can be used for single-screen images to be used in DeluxePaint, Paintworks Gold 
and AppleWorks GS. 

About Paintworks Files 
The Paintworks (type $CO\O) file saves two screens of an image. Paintworks files are 
compressed. This file format can be used for double-screen images to be used in 
Paintworks. 
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Transferring to Another Program 
Transfer allows you to launch another program (such as ThunderScan or ThunderScan 
GS) without having to quit and reload. To transfer to another application: 
• Select Transfer from the File menu. A dialog box appears. 
• Use the mouse to select the program to launch and click on the Open button. The 

selected program will be loaded. 

Quitting 
When you're finished using your scanner, choose Quit from the File menu. If you've 
forgotten to save an image, a dialog box will appear to give you the opportunity to save 
or cancel instead of quitting. 

Where to Go Next 
Now that you've learned to scan and save an image, you're ready to learn about the 
other programs that are included on your LightningScan GS program disk: ThunderScan 
and ThunderScan GS. Chapter Four, Using ThunderScan GS, and Chapter Five, Using 
ThunderScan, explain everything you need to know to colorize, print, and save your 
image for use in High Res and Double Res applications. 
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Chapter Four - Using ThunderScan GS 

About ThunderScan GS 
ThunderScan GS is a disk-based application that requires a minimum of 768K of 
memory. ThunderScan GS allows you to display images in both the 640 and 320 modes. 
It lets you copy files to the clipboard, colorize, and tile print. 

Opening Images 
To launch ThunderScan GS: 
• Choose ThunderScan GS in the Program Selector. 

ThunderScan GS loads files saved in the ThunderScan format. It will not load screen files. 
To load an image: 
• Select Open •.. from the File menu (or press Command-D). 
• Click on the Disk button to change volumes. 
• Select the file you want and click on the Open button (or press the Return key). 

ThunderScan GS loads the file. 

Scrolling an Image 
You can scroll an image that is larger than the window-right or left, up or down. To 
scroll: 
• Move the pointer onto the arrows of either the vertical or horizontal scroll bars of the 

image window. 
• Click the mouse button to move in small increments. 
• Slide the scroll box to move in larger increments. 

When you release the mouse button, ThunderScan GS pauses to refresh the screen by 
reading a new section of the image from disk. 

Using the Clipboard 
Copy puts a selected part of an image into the Clipboard. The Cut and Paste commands 
do not work and are dimmed. An image copied to the Oipboard will not retain its con­
trast, brightness and filter settings. 
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To copy an area to your Oipboard: 
• Choose Copy from the Edit menu (or press Command-C). The pointer (~) changes 

into a cross bar (+). 
• Move the cross bar onto the image area. 
• To select a portion of the image, hold down the mouse and drag the cross bar over 

the portion of the image you desire (the maximum area that can be copied is a single 
screen). 

Changing Contrast and Brightness 
ThunderScan's contrast and brightness controls are identical to the controls in Light­
ningScan GS. The brightness control makes the image lighter or darker. The contrast 
control alters the range of grays in an image. When contrast is increased, dark grays 
become black and light grays become white. Contrast and brightness settings affect the 
entire image. 

To adjust the contrast and brightness of your image: 
• Select Contrast & Brightness ... from the Scanner menu (or press Command-B). 

The contrast and brightness scroll bars appear on screen: 

100 0 

C B 

~ 
n Cancel D 

Figure 4-1 
The contrast and brightness controls. 
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The standard settings are 0 for brightness and 100 for contrast. To change the contrast 
and brightness: 
• Use the mouse and click on the arrows or drag the scroll box of the brightness and 

contrast scroll bars. 

Click on the OK button when you have reached the satisfactory settings. Or, click on the 
Cancel button (or press Return) if you wish to cancel your changes. 

Protect Controls 
Changes to contrast and brightness affect the entire screen, including the menus, 
windows and all other controls. This means that it is possible to make the controls 
disappear if extreme changes are made to contrast and brightness. To guard against this, 
ThunderScan GS comes with Protect Controls turned on. If Protect Controls is turned off, 
you may notice that when the brightness or contrast controls are adjusted to either 
extreme, the screen may tum completely black or white. Press the Return key to cancel 
the contrast and brightness controls and return to the image window. When using 
Protect Controls brightness and contrast settings will not affect the absolute black and 
white pixels of an image. 

Using the Filter 
The Filter allows you to create a multitude of special effects. You can create negatives, 
add color, or simply view the percentage of grays that make up the image. 

To use the filter: 
• Select Filter ... from the Scanner menu (or press Command-F). 
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The filter dialog box appears: 

(% gray) 

10 5 9 
3 o 4 

Filter 

8 2 
7 8 

6 11 
5 

o 
17 

!····I·:·:·:-:·JH+HlmmmEim_' ••••••••••••• :':':':': : ::: ::::: IeXXX 

:::: ::::::::: ~ :l:l:l:l mmm ~=== 

MiHing PGlette ---------' 

n Rccept » Reset Cancel 

Figure 4-2 
The filter dialog box. 

There are three palettes: gray, mixing and color. The top palette, the gray palette, shows 
the 16 possible shades of gray. The numbers at the top of the gray palette show the 
percentage of each shade present in the screen currently being viewed. The percentages 
of gray values will serve as a reference when using the color palette. 

The mixing palette lets you combine gray values from the gray palette and colors from 
the color palette to change an image. Shades or colors are dragged from the gray or color 
palettes onto the mixing palette. Here are a few ideas: 
• To invert an image, reverse the order in the mixing palette. Drag grays from the gray 

palette onto the mixing palette so white is represented by black, black by white, and 
soon. 

• To posterize an image, copy one shade to three or four shades in the mixing palette. 
The end result is an image that has fewer levels of gray. 

Try it for yourself. When you feel you have achieved a desired effect, click on the Accept 
button to view the image. You can revert to the standard the gray palette by clicking on 
the Reset button. 
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In the 640 mode (Ultra Res), the mixing palette consists of four mini-palettes with four 
entries in each. Changes made to one mini palette affect all mini-palettes. 

The black and white values in the mixing palette will affect the menus, windows and all 
other controls. Consequently, you should never set black and white to the same value. 
Otherwise, menus and commands will become invisible. If Protect Controls is turned on, 
you will not be able to alter the black and white values in the mixing palette. If you make 
your controls invisible, simply press Command-F to return to the filter screen and correct 
the palette. 

Switching Display 
ThunderScan GS allows you to change the format and mode of images. To change format 
or mode: 
• Select Switch Display ... from the Scanner menu. The switch display dialog box will 

appear: 

Switch Display to ... 

Format 

@ Super Res 

o Ultra Res 

n Rccept » 
Figure 4-3 

Mode 

@ Color 
o line Rrt 

Cancel 

The switch display dialog box. 

Use the mouse to select the desired settings. You can change the format from 320 (Super 
Res) to 640 (Ultra Res) or switch modes from color to line art. The Line Art mode is 
available in the Ultra Res format and will be dimmed when Super Res is selected. Oick 
on the Accept button to view your changes. Click on the Cancel button to ignore the 
changes and return to the image window. 
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Saving Scanned Images 
After you have finished playing with your image, you may wish to save it. ThunderScan 
GS saves images in the popular file formats so they can be used with almost any graphic 
program for the Apple lIes. 

To save a scanned image: 
• Select Save As ... from the File menu (or press Command-S). The scan file format box 

appears: 

Select Saue file-format 

Apple GS paint: 

o Apple-Preferred ($CO\2) 
o Single Screen ($C 1 \0) 
o Double Screen ($CO\O) 

ThunderScan: 

@ Scan file 

( Cancel) 

Figure 4-4 
The scan file format box. 

Saving as a ThunderScan File 
Saving as a ThunderScan file saves the entire image you've created. Scan files can be 
reloaded in ThunderScan GS or into ThunderScan so you can make changes to bright­
ness, contrast, and the filter. Scan files are the only files ThunderScan GS can load. Be 
sure to keep a copy of your images as scan files in case you need to use them again. 

Saving as Screen Files 
Screen files can be used with a variety of different programs, but they cannot be loaded 
into ThunderScan GS or into ThunderScan. Before saving an image as a screen file: 
• Make sure the brightness, contrast, and filter controls are set to your liking. 
• Use the scroll bars to position the image for saving. The area displayed will be saved. 
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The Apple-Preferred ($CO\2) file saves one screen of the image. It is a compressed file 
and takes up less space than the Single Screen file. The Apple-Preferred file is supported 
in programs like DeluxePaint IT, Paintworks Gold, and AppleWorks GS. 

The Single Screen ($Cl \0) also saves one screen. It is an uncompressed file and will 
require 65 blocks on disk. Single screen files can be imported into almost any painting 
program. 

The Double Screen ($CO\O) saves two screens of an image, the screen being viewed and 
the one directly below it. It is a compressed file. Double screen files can be used in 
Paintworks Plus and Paintworks Gold. 

Once you have decided on a file format: 
• Use the radio buttons to select your choice. 
• Click on the OK button (or press the Return key). Clicking on the Cancel button will 

exit the save dialog and return to the image window. 

After clicking on the OK button, another dialog box will appear: 
• Type in a filename. 
• Click on the Accept button (or press the Return key). 

Printing with an ImageWriter 
ThunderScan GS allows you to print with an ImageWriter. This section explains how to 
print an image with the ImageWriter and the options available. 
• Use the scroll bars to position the image in the window to be printed. ThunderScan 

GS prints an 8 X 10 inch area from the upper left corner of the image being displayed. 
• Select Choose Printer ... from the File menu and select the desired printer. 
• Choose Print. .. from the File menu (or press Command-P). 
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The lmageWriter page setup dialog box appear: 

I mageWriter /Printer 

Paper: @ US letter 
o US le~al 
o R4letter 
o International Fanfold 

Uertical Sizing: 
@Normal 
o Condensed 

Orientation: 

Figure 4-5 

Printer Effects: 
D 50 10 Reduction 
D No Gaps Between 

Pages 

( Cancel) K OK II 

The lmageWriter page setup dialog box. 

Normal should be selected for the Vertical Sizing option. Condensed will cause images 
to be compressed vertically in size. 50% Reduction should be used when you are print­
ing line art images. Gray shade images may appear too dark when printed at 50% reduc­
tion with an ImageWriter. 
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After the page setup options are set to your liking, click on the OK button to proceed. 
The print dialog box appears with further printing instructions: 

I mageUJriter /Printer 

Quality: o Detter TeNt 
@ Detter Color 
o Draft 

Page range: @ RII 
o From: D To: D 

Copies: lal 
Paper Feed:@ Rutomatic 0 Manual 

o Color ( cancel) n OK D 

Figure 4-6 
The ImageWriter print dialog box. 

• Better Color should selected as the Quality (Better Text and Draft are used for 
printing text). 

• If you have an ImageWriter II and a color ribbon, you'll be able to print your images 
in color. (You'll want to colorize your image using the filter palettes first). 

• Click on the OK button. 

Printing begins after a few moments. 

Stopping Printing Early 
To stop printing before the ImageWriter is finished: 
• Hold down the Command key and type a period(.). 

After a few moments, printing will stop. ThunderScan GS returns to the image window. 
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Printing with a LaserWriter 
If you have a LaserWriter available, you'll be able to print PostScript® halftones. Before 
you begin you'll want to make sure your system is properly configured for use with a 
LaserWriter. Since the ImageWriter requires the printer port, your LaserWriter should be 
connected to the modem port. To prepare your LaserWriter for printing: 
• Make sure the LocalTalk™ cable is connected to the modem port on your Apple IIGs. 
• Enter the Control Panel and make sure it is configured for AppleTalk in slot 7 and 

Your Card in slot 2. 
• Select Choose Printer ... from the File menu. 
• Use the mouse to choose printer type (LaserWriter) and printer port (Modem). Click 

on the OK button. 

Choose Page Setup from the File menu. The LaserWriter page setup dialog box appears: 

laserWriter 
Paper: @ US letter 

o US Legal 

Orientation: 

I~ 

o R4letter 
085 letter 

Uertical Sizing: 
@Normal 
o Intermediate 
o Condensed 

Reduce or I'iiiftil 
Printer Effects: Enlarge:. % 

DSmoothing? ~ 
o Font Substitution? ( Cancel ) ~ 

Figure 4-7 
The LaserWriter page setup dialog box. 

You can make changes to printed resolution and orientation through Page Setup. The 
Vertical Sizing options are generally used for printing text files, but can also alter printed 
graphics. The Intermediate and Condensed options will compress images vertically. The 
Smoothing and Font Substitution options are ignored in ThunderScan GS. 
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The Reduce or Enlarge option controls the printed resolution and size of printed images. 
Use 100% to print the image at actual size as it appears on the screen. Use a 50% reduc­
tion to print an image that is half the length and width of the actual size (1/4 of the area) 
with twice the resolution. 

To print to the LaserWriter, choose Print. .. from the File menu (or press 
Command-P}.The LaserWriter print dialog box appears: 

LaserWriter 

Page: @ All D o From: To: D 
Copies: 101 
Paper Source:@ Paper Tray 

o Manual 

( Cancel) n OK n 

Figure 4-8 
The LaserWriter print dialog box. 

• Set the number of copies and the paper source. 
• Click on the OK button. 

In a few minutes, your image will print. 
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Tile Printing 
Tile printing prints your entire scanned image on a series of pages (when the image is 
larger than 8 X 10 inches). Tile printing starts at the upper left comer of the image dis­
played on screen and continues printing the entire image on separate pages. The pages 
may then be pasted or taped together. Tile printing is ideal for creating posters. In most 
cases, you'll want to use the tile printing option. The Apple IIGS requires extra memory to 
large images, so it is possible to create an image that is too large to print. 

To tile print: 
• Scroll the image to be printed so that the upper left corner of the area to be printed 

image is in the upper left comer of the screen. 
• Access the Control Panel to select the desired printer. 
• Select Tile Print from the File menu (or press Command-T). 

The print dialog box appears. 
• Set the mode for printing. 
• Click on the OK button. 

ThunderScan GS will prepare the data for printing. Tile printing can take a while. Be­
cause of the nature of Apple's printer drivers, extraneous data may be printed to the 
right side of the image. This strip of misprinted area can be trimmed away with scissors. 
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Quitting ThunderScan GS 
When you're finished using ThunderScan GS and want to leave the application: 
• Choose Quit from the File menu (or press Command-Q). 
• Click on the Yes button to exit ThunderScan GS. 

If you have not saved the current image, a dialog box will appear: 

Do you want to saue the 
current image? 

No 

Figure 4-9 
The save changes dialog box. 

(cancel) 

• Click on the Yes button if you want to save the image. 
• Click on the No button if you don't wish to save your image or any changes you 

might have made. 
• Click on the Cancel button to return to the image window. 
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Chapter Five - Using ThunderScan 

About ThunderScan 
ThunderScan is a ProOOS 8-based program that requires only 64K of memory to load 
images from disk. ThunderScan has a special print grays option for printing high quality 
gray scale images. You can use it to change images to the High Res and Double Res 
formats. ThunderScan is compatible with the Apple lIe, lIc, and lIes computers. 

Launching ThunderScan 
To launch ThunderScan: 
• Select ThunderScan from the Program Selector. 

ThunderScan's Main Menu appears: 

THUNDERSCAN FOR THE APPlE II - YER 1.2 

H)EW SCAN 
S)AV£ SCAN 
O)NlINE VOlUM£S 
l)OAD FILE 
O)ISPLAV 
P)RINT IMAGE 
C)ONFIGURE 
tI)UIT 

ENTER THE FIRST LITTER: 
THEN PRESS <RETURN> TO "'CCEPT 

Figure 5-1 
ThunderScan Main Menu. 
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Checking Online Volumes 
To check the online volumes: 
• Press 0 (for Online) from the Main Menu. 

Find the volume of the file you wish to load. You'll need to know the volume name 
where the image resides in order to load it. 

Loading an Image from Disk 
To load an image, start from the Main Menu: 
• Type L (for Load) and press the Return key. 

The load screen appears: 

,.. 
LOAD A SCAN FILE FROM DISK 

ENTER A SCANFILE OR DIRECTORY PATHNAME 
-->: 

PRESS <ESC> TO GO BACK TO MAIN MENU. 

Figure 5-2 
The load screen. 

• Type the complete pathname and press the Return key. 
• If you don't know the complete pathname, type the volume name and press the 

Return key. The files and/ or directories on the volume are listed. Use the Up and 
Down Arrow keys to move the highlighting to a Scan Image file (or directory) from 
the list. 

• Press the Return key to accept your choice. The file name (or directory) you've 
chosen appears after the name of the current disk. (If you selected a d irectory, repeat 
this process until the complete pathname appears.) 

• Press the Return key to confirm your choice. 
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Changing Format and Mode 
ThunderScan allows you to change the fonnat and mode of images scanned with 
LightningScan GS. Format detennines the resolution and number of shades or colors 
displayed in an image. You can choose from four formats: Special, High Res, Double Res, 
Ultra Res, and Super Res. The Super Res and Ultra Res formats in ThunderScan are the 
identical to the 320 and 640 modes in LightningScan GS. 

resolution display 
format (horiz. x vert.) shades 

Special 280 x 192 2 

High Res 280 x 192 2 

Double Res 560 x 192 2 

140 x 192 16 

Super Res 320 x 200 16 

Ultra Res 640 x 200 4 

Figure 5-3 
Fonnats, resolution and displayed shades. 

Depending on the format selected, there are four modes: Halftone, Line Art, Grays and 
Color. Mode detennines how an image is displayed on your screen. 

Halftone uses black and whites dots to represent shades of gray. Halftone is not available 
in the Super Res and Ultra Res modes. 

Line Art displays images in high contrast. Lighter areas have more white dots, while 
darker areas have more black dots. Line Art is not available in the Super Res mode. 

Color displays images in color and/ or grays. See the section Using the Filter, in this 
chapter, to learn more about assigning colors to shades of gray. Color is not available in 
the Special and High Res modes. 
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To change the format and mode of an image: 
• Press D (for display). 

CHANGE D ISPLA Y FORMAT AND MODE 

ORIGINALLY SCANNED FOR: SPECIAL 

F)ORMA T: SUPER RES 
M)ODE: COLOR 

PRESS (RETURN) TO DISPLAY SCAN IMAGE. 
PRESS (ESC) TO CANCEL AND GO BACK. 

Figure 5-4 
The switch display screen. 

• Press F (for format) until the desired format appears. 
• Press M (for mode) until the desired mode appears. 
• Press the Return key to view your image with the new display settings. 

Scrolling an Image 
The screen is just a "window" over the larger image. To scroll the image: 
• Use the appropriate Arrow key (Up, Down, Right, or Left) to move the image in the 

direction you want. 

To scroll inches at a time: 
• Hold down the Option or Command key while scrolling. When you've reached the 

edge of your image, your computer will beep. 
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Adjusting Brightness and Contrast 
ThunderScan -like LightningScan GS and ThunderScan GS - gives you the ability to 
change brightness and contrast. To adjust the brightness of your image: 
• Press B (for Brightness). 

The brightness and contrast control appear at the bottom of the screen. You operate the 
slider on these controls with the Left and Right Arrow keys. 
• Press the Right or Left Arrow key to move the B in the brightness control to the right 

or left. 

Each time you press an Arrow key, you change the brightness by one point. The effects 
are instantaneous. 

To adjust the contrast of your image: 
• Press C (for Contrast). 
• Press the Right or Left Arrow key to move the contrast higher or lower. 
• To reset brightness and contrast to their normal setting, press C or B, and then press 

N (for Normal). 

Important Note: Adjusting contrast and brightness to the maximum or minimum settings 
may cause the screen to tum completely gray. Press the ESC key to cancel your settings. 

Using the Filter 
You access the filter for the format and mode you've selected by pressing F (for Filter) 
while an image is on screen. Depending on the format and mode that you've chosen to be 
displayed, one of three color filters will appear on screen. The actual shades in the left 
column are the 16 possible grays ranging from white to black. The palette, on the right, is 
a collection of grays (or colors) that you can use to represent the actual grays on the 
screen or in printing. The assigned shades, in the middle, are the shades chosen from the 
palette for each actual shade. Normally, the assigned shades are the same as the actual 
shades. 
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If you've changed the display to either High Res or Double Res, the HalftonelLine Art 
Gray Filter will let you choose from the standard palette of 16 levels of gray (except in 
the color mode). Although the High Res and Double Res formats don't actually display 
grays on the screen, this filter determines the distribution of white and black dots for the 
dithered image which represents grays. 

You can use this filter to make a negative image. Simply reverse the order of the assigned 
shades, so that white is represented by black, black by white, and so on. 

,.. 
~H HAlFTONE/lINEAIH GRAY fllTERH~ ~ 

---------------------- ---------
ACTUAL ASSIGNED PALETTE 

-------- ----------
WHITE WHITE WHITE 
GRAY 1 GRAY 1 GRAY 1 
GRAY 2 GRAY 2 GRAY 2 
GRAY 3 GRAY 3 GRAY 3 
GRAY 4 GRAY 4 GRAY 4 
GRAY 5 GRAY 5 GRAY 5 
GRAY 5 GRAY 5 GRAY 5 
GRAY 6 GRAY 6 GRAY 6 
GRAY 7 GRAY 7 GRAY 7 
GRAY B GRAY 8 GRAY B 
GRAY 9 GRAY 9 GRAY 9 
GRAY 10 GRAY 10 GRAY 10 
GRAY 11 GRAY 11 GRAY 11 
GRAY 12 GRAY 12 GRAY 12 
GRAY 13 GRAY 13 GRAY 13 
GRAY 14 GRAY 14 GRAY 14 
BLACK BLACK BLACK 
--- --- - -- --- -- -- -- --------- -- ----

H) ISTOGRAM R)ESET 

... ~J OPTION AND AR~~ W~ TO &~~~T AND IGN COLORS. PRE <R U H> T . 

Figure 5-5 
Halftone/Line Art Gray Filter. 
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If you have a color monitor and have selected the Color mode, the Double Res Color 
Filter appears. It lets you assign different colors to grays. Color allows you to create 
different and unusual effects with your images. 

,. 
__ ~~~ _D.9J.1.!lg: ~L~E?_~0..Lg~!1 ~ lE..R_*_*_* __ __ " ACTUAL ASSIGNED PALmE --------- ---- --- -- -- ----------WHITE WHITE WHITE 

GRAY 1 YELLOW 'fELLOW 
GRAY 2 GRAY 2 GRAY 2 
GRAY 3 PINK PIHK 
GRAY 4 AQUA AQUA 
GRAY 5 LT BLUE LT BLUE 
GRAY 6 GREEN GREEN 
GRAY 7 OK GREEN OK GREEN 
GRAYS PURPLE PURPLE 
GRAY 9 RED RED 
GRAY 10 ORAt«iE o Roll t«iE 
GRAY 11 BROWH BROWN 
GRAY 12 GRAY 1 GRAY 1 
GRAY 13 BLUE BLUE 
GRAY 14 OK BLUE OK BLUE 
BLACK BLACK BLACK 

------- -- ------------------------
H)ISTOGRAH R) ESET 

USE OPTION AND ARROW KEYS TO SELECT "HD 

... ASSIGN COLORS. PRESS (RETURN> TO EXIT . 

Figure 5-6 
Double Res Color Filter. 

If your image is displayed in the Super Res or Ultra Res format, the SuperlUltra Res 
Gray/Color Filter will appear. It lets you select either 16 grays or colors from a palette of 
16 grays and 16 colors. You can choose all gray, all color, or a combination . 

,. 
"" SUPER/ULTRA-RES GRA'I/COLOR FILTER"" 

...., 
-------------------------------------------

ACTUAL ASSIGNED PALETTE 
--------- ---------- -------------
WHITE 'IELLOW WHITE 'IELLOW 
GRA'I1 'IEL-GRN GRAY 1 'IEL-GRN 
GRAY 2 CYAN GRAY 2 CVAN 
GRA'I3 AQUA GRAY 3 AQUA 
GRAV 4 ORNG-VEL GRAV 4 ORNG-VEL 
GRA'IS GREEN GRAY S GREEN 
GRAV 6 LT BLUE GRAY 6 LT BLUE 
GRAil 7 ORANGE GRAV 7 ORANGE 
GRAV 6 RED-ORNG GRAY 6 RED-ORNG 
GRA'I9 RED GRAY 9 RED 
GRAV 10 MAGENTA GRAY 10 MAGENTA 
GRAV 11 PINK GRAY 11 PINK 
GRAV 12 VIOLET GRAY 12 VIOLET 
GRAY 13 PURPLE GRAV 13 PURPLE 
GRAV 14 MED BLUE GRAY 14 MED BLUE 
BLACK OK BLUE BLACK OK BLUE 
----------------------------------------------

H)ISTOGRAM R)ESET 
USE OPTION AND ARROW KEllS TO SELECT AND ... ASSIGN COLORS. PRESS <RETURN> TO EXIT. ....,.j 

Figure 5-7 
Super/Ultra Res and Gray /Color Filter. 
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If you've chosen the Ultra Res format and Line Art mode, the Ultra-Res Line Art Filter 
appears. It provides a palette of four levels of gray. 

,.. 

... 

*** ULTRA-RES LlNEART F IL TER *** ---------------------------------------
ACTUAL ASSIGNED PALETTE 

WHITE 
GRAY 1 
GRAY 2 
GRAY 3 
GRAY 4 
GRAY 5 
GRAY 6 
GRAY 7 
GRAY B 
GRAY 9 
GRAY 10 
GRAY 11 
GRAY 12 
GRAY 13 
GRAY 14 
BLACK 

WHITE 
WHITE 
WHITE 
WHITE 
GRAY 5 
GRAY 5 
GRAY 5 
GRAY 5 
GRAY 10 
GRAY 10 
GRAY 10 
GRAY 10 
BLACK 
BLACK 
BLACK 
BLACK 

--w"H-ITT---­
GRAY 5 
GRAY 10 
BLACK 

H)ISTOGRAM R)ESET 
USE OPTION AND ARROW KEYS TO SELECT AND 
ASSIGN COLORS. PRESS (RETURN) TO EXIT . 

Figure 5-8 
Ultra Res/Line Art Filter 

Important Note: The Super Res and Ultra Res filters default to grays. Press R (for Reset) to 
toggle between between color and gray palettes. 

Using Filters to Change Shades 
You can adjust the way that shades of gray and colors are displayed on the screen by 
assigning alternate shades from the palette. First choose the filter you want, then adjust 
the assigned shades. 

You can look at the filters when you are displaying an image. To see the filter for your 
format and mode: 
• Press F (for Filter). 

You can choose new grays or colors from the palette to represent the actual grays re­
corded for an image. The instructions for changing the shades are the same for all filters. 

54 Chapter Five - Using ThunderScan 



To select the shade you wish to change, you must first make sure the Assigned Shades 
column is activated by highlighting the Assigned column head: 
• If the column head is not already highlighted, press the Left Arrow key. 

You may now proceed to select a shade to change. You select a shade by highlighting it: 
• Press the Down and Up Arrow keys to move the highlighting up and down in the 

Assigned Shade column. 

Once you've highlighted a shade, you can change it. The currently assigned shade is 
highlighted in the palette. You can select a different shade from the palette to represent 
the assigned shade. 

To select a different shade from the palette: 
• Press the Right Arrow to activate the Palette column. The column head will be 

highlighted. 
• Press the Up or Down Arrow keys to select a different shade. 

As you move the highlighting through the shades of the palette, the setting of the as­
signed shade changes. To change another shade, use the Left Arrow to activate the 
Assigned Shades column once more, and repeat the above procedure. 

Copying Assigned Shades 
If you want the image to appear in just a few shades for a posterized effect, you can copy 
shades instead of changing each assigned shade individually. To copy an assigned shade: 
• Activate the Assigned Shades column, and select the shade you wish 

to change by highlighting it with the Up or Down Arrow keys. 
• Activate the Palette column by pressing the Right Arrow key and 

selecting the first shade you want to copy. 
• Use the Left Arrow key to return to the Assigned Shades column. 
• Hold down the Option key or the Command key and press the Up Arrow key to 

copy up, or the Down Arrow key to copy down. 

Each time you press the Up or Down Arrow key, you copy the selected palette shade to 
the adjacent assigned shade. 
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Resetting the Filter 
If you decide you don't like the changes you make to a filter, you can reset it to normal. 
To reset a filter: 
• Press R (for Reset). 

The assigned shades become the same as the actual shades once again. If you're using the 
Super Res or Ultra Res format, pressing R more than once will cause a filter to alternate 
between standard settings for grays and color. 

Using the Histogram 
ThunderScan's Histogram shows what percentage of each shade is present in a screen 
image. It serves as a guide when you are using the filters to assign shades and colors. 

You can see a histogram when you are using the filters to assign shades and colors. To 
see a histogram: 
• Press H (for Histogram). 

A histogram like this one appears: 

,.. 
HISTOGRAM OF CURRENT SCREEN IMAGE 

WHITE 
GRAV 1 
GRAV 2 
GRAV 3 
GRAV 4 
GRAV 5 
GRAV 6 
GRAV 7 
GRAV 8 
GRAV 9 
GRAV 10 
GRAV 11 
GRAV 12 
GRAV 13 
GRAV 14 
BLACK 

Figure 5-9 

~ 
a*******· 
9********* 
7******* 
6****** 
3*** 
2** 
o 
5***** 
1* 
3*** 
B******** 
6****** 
4**** 

16******************* 
9********· 

13************* 

PRESS ANV KEI' TO EXIT. 

The histogram screen. 

If you press H before a screen is completely refreshed, the histogram will reflect only a 
portion of the screen showing instead of the entire screen. To leave the histogram press 
any key. 
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Saving an Image 
Images can be saved in two ways: as scan files or as screen files. The scan file, identical to 
the ThunderScan file in ThunderScan GS and LightningScan GS, saves the entire image. 
Scan files are the only kind that ThunderScan can load. The screen file saves only the 
image showing on the screen. Screens may be saved in High Res, Double Res, Super Res 
or Ultra Res fonnats for importing into other programs. Before saving as a screen file, be 
sure your image is displayed in the fonnat accepted by the program you wish to use it in. 

There are three additional screen file formats that are available in Super or Ultra Res: 
• A Paintworks Screen file can be used with painting programs like Paintworks. This 

file is a single screen in size. 
• A Paintworks Paint file saves the screen showing and a full screen below it. It can be 

used with painting programs like Paintworks. 
• A DeluxePaint II file saves the screen showing in Apple's Preferred File Format. It 

can be used with painting programs like DeluxePaint II. 

The following sections explain how to save an image in both the Scan Image and Screen 
File formats. 

Saving a Screen File 
To save an image as a screen file: 
• While displaying an image, use the arrow keys to position it on screen. 
• Use the contrast, brightness, and filter controls to fine-tune your image. 
• Press S (for Save). A screen appears: 

SA YE THE CURRENT SCREEN AS A FILE 

--) " 

Figure 5-10 

ENTER THE FILE PATHNAME 
AND THEN PRESS RETURN 

PRESS <ESC> TO CANCEL ---

The screen save screen. 
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• Type a slash (j) followed by a full pathname. The name of the screen file must be 
different than the name of the scan file to avoid errors. 

• Press the Return key. 

If your image is displayed in Super Res or Ultra Res, an additional screen will appear: 

,.. 

... 

CHOOSE A SCREEN SAVE FILE FORMAT 

PA INTWORKS (PAINT) 
PAINTWORKS (SCREEN) 
OELUXEPAI NT II 

USE ARROWS KEYS TO SELECT FILE FORMAT 
PRESS (RETURN) TO ACCEPT 
PRESS (ESC) TO CANCEL SAVE . 

Figure 5-11 
The screen save file format screen. 

Printing an Image 
ThunderScan offers many options for printing on your ImageWriter. Before printing an 
image, you must load a scan file. To print with an ImageWriter: 
• Go to the Display screen and use the arrow keys to position the image on the screen. 

The upper left corner of the screen will be the upper left corner of your printout. If 
you want to print the entire image, use the Arrow keys to move to the upper left 
corner. (You'll know you've reached an edge when your Apple beeps.) 

• Make sure you've adjusted the image to your satisfaction with the contrast and 
brightness controls. 

• Press the ESC key to go to the Main Menu . 
• Type P (for Print) and press the Return key. 
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A screen appears: 

,.. 
PREPARING TO PRINT AN IMAGE 

F)ILTER 
D)ENSITY: NORMAL (72 DPI) 

i)NDENT: 0.0 INCHES 
W)IOTH: 8.0 INCHES 
UENGTH: 10.0 INCHES 

M)ODE: HALFTONE C)OlOR: BLACK 

PRESS <RETURN> WHEN READY TO PRINT. 
PRESS <ESC> TO GO BACK TO THE MAIN MENU. 

Figure 5-12 
The prepare to print screen 

The prepare to print screen lets you change the filter for printing, select the print density, 
specify a location on your page for the image to print, and change styles for printing. 
ThunderScan prints images in three different styles: halftone, line art, or gray. 

• The Halftone style is usually best for images that contain grays, such as photographs. 
• The Line Art style is best for high contrast images with few or no grays. Maps, sche­

matics, and logos are examples of images that usually print best in the line art style. 
• The Gray style is usually best for low contrast images with a lot of intennediate gray­

shades. ThunderScan directs the ImageWriter to make extra passes to create a 
layered effect for more accurate printing of grays. Expect images printed in the gray 
style to appear darker. For best results, use a well-used printer ribbon to compensate 
for the increased saturation of gray style printing. 
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You may wish to experiment with different printing styles to get the effect you desire. 
The following samples illustrate the difference between printing styles. 

Figure 5-13 
An example of ThunderScan's line art printing. 

Figure 5-14 
An example of ThunderScan's halftone printing. 
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Figure 5-15 
An example of ThunderScan's gray printing. 

Important Note: When printed in the halftone mode, some images may look slightly 
different from the way they appear on screen. If at first you don't achieve a desired 
result, use the contrast and brightness controls to alter the image to your satisfaction and 
then reprint it. 
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About Color Printing 
If you have an ImageWriter II and a color ribbon, you'll be able to print your images in 
any single color or in a variety of color combinations. To specify a single color: 
• Press the Return key to return to the prepare to print screen, if necessary. 
• Press M (for Mode) until you see the Halftone, Line Art, or Gray style you 

desire. 
• Press C (for Color) until you see the color you want. 

If you choose to print with your ImageWriter II using the COLORS mode, your image 
can be printed in up to seven colors. Using the ImageWriter II Color Filter, you can 
assign each of the 16 levels of gray to a color: 
• Press M (for Mode) from the prepare to print screen, until you see the colors mode. 
• Press F (for Filter). 

The ImageWriter II Color Filter appears: 

,.. 
* u IMAGEWRITER I I COLOR fILTERU* 

-------------------------- -- --- - --- -
ACTUAL ASSIGNED PIILETTE 

- ---- -- - - ¥i-Hl l E - -- - - ,- - - WHITE - --- --WHITE 
GRAY 1 WHITE YELLOW 
GRAY 2 YELLOW ORANGE 
GRAY 3 YELLOW RED 
GRAY 4 ORANGE GREEN 
GRAY 5 ORANGE BLUE 
GRAY 6 RED PURPLE 
GRAY 7 RED BLACK 
GRAY 8 GREEN 
GRAY 9 GREEN 
GRAY 10 BLUE 
GRAY 11 BLUE 
GRAY 12 PU RPLE 
GRAY 13 PURPLE 
GRAY 14 BLACK 
~~~_~ ____ _ ~~~~ ____ __ l _____ ___ ____ 

H) ISTOG RAM R)ESET 
USE OPTION AN D ARROW KEYS TO SELECT AND ... ASSIGN COLORS. PRESS (RETURN) TO EXIT. ..... 

Figure 5-16 
The ImageWriter 11 color filter. 

This filter gives you control over the appearance of your printout. The ImageWriter II 
Color Filter works in the same way the filters work which control the appearance of an 
image on the screen. To help you decide which colors to assign to grays, you can use the 
Histogram and Reset options as outlined in other sections. To achieve other color effects, 
you may wish to use the printing options found in many painting programs. 
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Choosing a Density 
You can print your image at normal density, or you can specify higher density printing to 
print at 50% reduction. If you select High Density, you'll get an image half the size (1/4 
the size by area) but double the resolution. If you choose this option, you may want to 
increase the brightness and lower the contrast of the image (while the image is on screen) 
or use an older ribbon with slightly faded ink when printing. 

Determining Location and Printout Size 
The indentation setting determines how far from the left edge of the page the image will 
print. The width and length settings determine how much of the image (up to 8" by 10") 
will be printed. To change indentation, width, or length: 
• Press the letter for the setting you want to change. 
• Use the Left and Right Arrow keys to adjust the settings. 

When you're finished with the printing setting, press the Return key. 

A screen appears with some reminders. Be sure that there is paper in the printer. Tum on 
the printer and check to see that the select light is on. When you're ready to print: 
• Press the Return key. 

ThunderScan starts to print your image. After printing is finished, you return to the Main 
Menu. 

Stopping Printing Early 
To stop printing before the ImageWriter is finished: 
• Press the ESC key. 
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Quitting ThunderScan 
When you're finished using ThunderScan, go to the Main Menu to quit: 
• Type Q (for Quit) and press the Return key. 

If you're using a working copy of the program disk, you'll return to the program selector. 
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Chapter Six - Troubleshooting and Maintenance 

If You're Having Problems 
If you're having trouble using LightningScan G5, this chapter should help you. Find the 
section that best describes the trouble you're having and use the suggestions given to 
solve the problem. 

Alert Boxes 
This section takes a brief look at some of the alert boxes you may experience while using 
LightningScan G5. The following are the most common problems and their solutions. 

Memory Errors 

The scanner hardware 

has been idl e too lono 

« Done Scan D [ Restart) 

Problem: 
Solution: 

You've used up the available memory during the scan. 
Click on either the Done Scan or Restart Scan buttons. To free up memory, 
close desk accessories. If you are using a RAM disk, turn it off and restart 
your computer. 

OS ERROR ~8 

Volume full 

Problem: 
Solution: 

[ OK » 
You have used up all available disk space. 
This is an example of an operating system error. Save your image to 
another disk where space is available. 
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Scanner Errors 

The scanner hardware 

has been idl e too long 

« Done Scan D ( Restort 

Problem: 

Solution: 

To prevent the scanner from being left on accidentally, the software turns 
the scanner off after being idle for 45 seconds. 
Click on either the Done Scan or Restart Scan buttons in the alert box. 

Streaked Scans 
Bright overhead lights can cause vertical streaks in images created with hand-held 
scanners. If you notice vertical streaks in images, dim the lights or cover the tinted 
window of the scanner with a piece of paper while scanning. 

Problems when Changing Resolutions While Scanning 
Changing the resolution switch without restarting the scan can cause the software to 
become confused. The image may become distorted and pressing the ESC key will have 
no effect. If this happens, press the start button and drag the scanner a few inches. This 
will unlock the software and the ESC key should function properly. 

If You Can't Scan 
If you are having problems scanning, follow these steps to get the scanner running: 
• Select Set Slot from the Scanner menu and verify the slot you are using. 
• Quit the LightningScan GS application. 
• Tum off your Apple lIes and all other peripherals. 
• Check to see that the peripheral card and scanner are all properly connected. 
• Tum your Apple lIes on and launch LightningScan GS. 

If you are still encountering problems, try installing the LightningScan GS peripheral 
card in a different slot. 

Taking Care of Your Scanner 
Be kind to your peripheral card and scanner. Treat them as you would any piece of 
precision electronic equipment. They are pretty sturdy, but not unbreakable. They will 
hold up well under normal use. Avoid dropping them, of course, and try not to bump 
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them against hard objects. A void using your scanner on abrasive surfaces. This will 
prevent the lens from becoming scratched and will prevent the roller and elevating legs 
from wearing out. 

The scanner is virtually maintenance-free. If you notice dust gathering on the plastic 
window on the bottom of the scanner, use a cotton swab to brush out the dust gently. If 
you accidentally get dirt or a fingerprint on the plastic shield, brush away the large 
particles and clean it with a cotton swab moistened with glass or lens cleaning fluid . 
Gently rub the lens and dry it with the other end of the swab. 

Periodically, you may wish to clean your scanner, and may need to remove SnapGuide. 
To remove SnapGuide, slide one side off at a time. If your scanner becomes extremely 
dirty, call our technical support department for information on a thorough cleaning. 

Don't put things on top of the card or scanner. Put your scanner in a safe place when it's 
not in use. You might store the scanner in its original box or in a desk drawer. When 
storing the scanner always take special care of the clear plastic lens on the bottom. 
Scratches in the lens may result in diminished scan quality. Available from Thunderware 
is ScanPac"". ScanPac is a royal blue, all cotton, durable zippered pouch designed to store 
your LightningScan. Call our customer service department to order ScanPac. Use the 
anti-static bag included with LightningScan GS for storing and transporting the periph­
eral card. 

Returning Your Scanner for Service 
If you are still encountering problems after reading the above sections, contact us. If a 
member of our technical support department determines that your scanner needs service, 
he or she will issue a Returned Material Authorization (RMA) number for you to note on 
the outside of your package. 

If your scanner is under warranty, you must return a copy of your sales receipt to con­
firm the purchase date. Thunderware will promptly repair scanners and return them 
postpaid. Any repair work not covered under the warranty must be paid before we can 
return your scanner. To expedite the return of a scanner which requires an out-of­
warranty repair, please provide us with a MasterCard or VISA credit card number, 
expiration date, and the full name shown on the card, along with your scanner. 

Important Note: Thunderware cannot accept any unit without the required RMA number, 
so be sure to note it clearly on the outside of the package containing your scanner. Please 
make a note of your RMA number in case you need to inquire about the status of a 
returned scanner la ter. 
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